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Scope and Audience

Thank you for selecting the RAMP® 200 Platform, the rapid immunochromatographic system for
performing in vitro diagnostic analyses.

This manual is intended for operators of the RAMP® 200 and describes procedures available to users
with access rights up to supervisor level. Information specific to service procedures is not contained in
this publication.

How to Use This Manual

This manual is divided into the following parts:

Part A — Introduction: Contains an overview of the user manual and describes basic features and
functions of the RAMP® 200.

Part B — Warnings & Precautions: Contains important information about safe operation of the
RAMP® 200.

Part C — Unpacking and Setup: Contains information about the RAMP®200 delivery, packaging
and setup.

Part D — RAMP® 200 Basics: Contains information about the RAMP® 200 modules and startup
procedures.

Part E — Performing a RAMP® Test: Contains information about running an assay on the RAMP®
200.

Part F — Quality Control: Contains information about the RAMP® 200 QC procedures.

Part G — Working with Results: Contains information about the assay result handling on the
RAMP® 200.

Part H — Managing Settings: Contains general information about instrument, connectivity and
user administration settings for the RAMP® 200.

Part | — Editing Settings: Contains detailed information about instrument, connectivity and user
administration settings for the RAMP® 200.

Part J — Maintenance: Contains all necessary information concerning instrument maintenance
and cleaning.

Part K — Troubleshooting: Contains helpful information about troubleshooting.

Part L — Specifications: Contains information about technical data of the RAMP® 200.

Part M - Index: Contains an index to find information in the manual by keyword search.

Customer Information

Customer Training

Contact your local sales representative for any questions or information regarding RAMP® 200 training.

Customer Service

Contact your local sales representative for further information regarding the RAMP® 200 warranty.

Ordering Information

Replacement parts and consumable materials should be ordered from Response Biomedical Corp. When
ordering, please use the Response Biomedical catalog number and reference name for each item. For
more information, contact Response Customer Service at: 1.866.525.7267.

=% RESPONSE BIOMEDICAL 6
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Conventions Used in This Manual

Visual cues are used to help locate and interpret information in this manual quickly. This section explains

formatting conventions used in this manual.

Symbols

LOT

Procedural step

List item

Cross reference, consult manual

Fragile, handle with care

Keep away from rain

Do not re-use

Do not use if package is damaged

Temperature limitation

Reference/Catalogue number

Lot/Batch code

CONTENT| Contents of Kit

= BB >

IVD

E 1 <

m
(¢}

REP

M\
/M

Introduction

Use-by/Expiry date

Caution, consult accompanying

documents.

Indicates a situation which, if not avoided,
could damage device.

Electrical Hazard

Warning!

Indicates a hazard which, if not avoided,
could result in death or injury (i.e. fire,
electrical shock or explosion).

Consult Instructions for Use

In vitro diagnostic device

Contains sufficient for <n> Tests

Waste electrical and electronic
equipment (WEEE)
Do not dispose of this product in municipal

waste. Contact Response Technical Support
for disposal or recycling information.

Manufacturer

Authorized Representative in
the European Community

Conformité Européenne
CE Mark. Product meets the safety
requirements of the European Union

=% RESPONSE BIOMEDICAL
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Abbreviations

Abbreviation

Description

CFR
CM
CSA
DHCP
FCC
FTP
FTPS
HID
HRB
HTTP
HTTPS
IEC
IFU

IP
1QC
LED
LacC
MAC
NTP
RCU
RoHS
SN
ssL
TCP/IP
™
uL
usB
VGA
WEEE

Code of Federal Regulations

Control Module

Canadian Standards Association

Dynamic Host Configuration Protocol

Federal Communications Commission

File Transfer Protocol

File Transfer Protocol Over Secure Socket Layer
Human Interface Device

High Running Background

Hypertext Transfer Protocol

Hypertext Transfer Protocol Over Secure Socket Layer
International Electrical Commission
Instructions for Use

Internet Protocol

Internal Quality Control

Light Emitting Diode

Liquid Quality Control

Machine Address Control

Network Time Protocol

Reader Configuration Utility

Restriction of Hazardous Substances

Serial Number

Secure Socket Layer

Transmission Control Protocol/Internet Protocol
Test Module

Underwriters Laboratories Inc.

Universal Serial Bus

Video Graphics Array

Waste Electrical and Electronic Equipment

o RESPONSE BIOMEDICAL 8
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Overview

The RAMP® 200 is a system comprised of two primary components:
e ATest Module (TM) that analyzes sample tests.
e A Control Module (CM) that manages the sample test results that it receives from the TM.

Calibration and expiration information for Test Cartridges are uploaded to the CM through Lot Cards
that are included with the Test Kits.

To perform a Test, add a sample into the well of a Test Cartridge and then insert the Test Cartridge into
the TM. Once the Test Cartridge has been inserted, no further intervention is required. A barcode on the
bottom of the Test Cartridge is then read by the RAMP® 200 to determine the lot number. Information
loaded with the Lot Card identifies lot-specific parameters and expiration date. This ensures that an
expired cartridge cannot be used.

Analysis time is analyte-specific and typically takes approximately 15 minutes per sample. Analysis
results may be viewed on the RAMP® 200 display screen and/or output to a USB flash drive, computer or
network server, or printer.

The RAMP® 200 can be operated in either local (manual transfer) or network (auto transfer) mode.
Interaction with the RAMP® 200 is through its touchscreen display and user input is accepted from
either the touchscreen keyboard or an optional barcode scanner. Stored data, including results, can be
transferred via USB flash drive, sent to a printer or uploaded to a computer network.

Immunoassay Measurement Principle

The measurement process is based on the use of antibodies, biologically-derived binding agents that can
be used to specifically identify and bind to target analytes (e.g., analyte indicative of cardiac damage).
The RAMP® 200 Platform consists of two components: a disposable Test Cartridge that houses an
analyte specific immunochromatographic strip and a portable fluorescence analyzer. A "sandwich"
immunoassay format is followed. Target-specific antibodies are used to tag fluorescently labeled latex
particles. In addition, target-specific antibodies are immobilized at the detection zone of the
immunochromatographic strip. The RAMP® 200 also incorporates a quantitative Internal Standard that
is run and measured concurrently in every test. In a typical test, the operator adds sample, and antigen-
bound fluorescent particles are captured at the detection zone (i.e., the antigen is "sandwiched"
between the detection zone antibodies and the antibodies on the latex particle) and a portion of excess
particles that are not bound to antigen and do not bind at the detection zone are captured at the
control zone. The instrument measures fluorescence emitted by the complexes captured in the
detection and control zones and calculates a ratio between these measurements. The more analyte
present in the sample, the greater the number of antibody-binding sites that will be occupied, and
correspondingly, a greater number of fluorescently-labeled latex particles will be captured at the
detection zone.

=% RESPONSE BIOMEDICAL o



RAMP® 200 USER MANUAL Introduction

Result Interpretation

Refer to the individual RAMP® Test Instructions for Use (IFU) for a detailed description of result
interpretation. Depending on the test used, the result interpretation may vary due to specific Assay
properties.

RAMP® 200 - components

Full operation of the RAMP® System requires the use of RAMP® Test Kits and components. Optional
accessories include a printer and barcode scanner.

RAMP® 200 is comprised of the following components:

RAMP® 200 Control Module (CM)

User interface and connectors for all peripherals. Stores and displays Test results (view, print, transfer,
search, and filter/sort).

RAMP® 200 Test Module (TM)

Features two testing ports for performing simultaneous RAMP® 200 Assays. A maximum of three TMs
can connect to a CM.

Power Supply and Interconnect Cable

Power supply cord and interconnect cable to connect CM and TM.

USB Flash Drive

Pre-configured with:
e The following four file folders: patient, Iqgc, igc and log. For use in bi-directional information
transfer in a non-networked environment. Also contains a version of File Converter (Excel).

>+ Refer to Exporting or Printing Test Result or Event Log Data section.
>+ Refer to Manually Transferring/Printing Results section.

e The Reader Configuration Utility (RCU) software executable file. Allows customized settings for
the RAMP® 200.
e Electronic version of this User Manual.

=% RESPONSE BIOMEDICAL 10
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WARNINGS & PRECAUTIONS E
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User/Operator Qualification

Operation should be conducted by personnel who have undergone training. Prior to operating the
Platform, operators are required to have knowledge of relevant guidelines and norms as well as the
information and procedures contained in the User Manual and supplied USB.

Carefully follow the procedures specified in the User Manual for the operation and maintenance of the
RAMP® 200. Maintenance not described in the User Manual should be left to trained Response
Biomedical Technical Support personnel.

Summary of Warnings and Precautions

The RAMP® 200 and its related devices and accessories are designed to provide safe and reliable service
when used according to the instructions provided in this Operator Manual.

The following warnings and precautions should be followed in order to avoid unsafe actions with the
RAMP® 200 that could potentially result in personal injury or device damage.

For U.S. customers, the RAMP® 200 must be operated in a laboratory setting when used with the
RAMP® Cardiovascular Tests.

\ WARNING

To reduce the risk associated with potentially infectious patient samples:

e Do not spill specimen or sample fluids or any of the RAMP® 200 components or on the outside
of the Test Cartridge.

o If aspill occurs, disinfect external surfaces only using a soft cloth containing a solution of 0.5%
bleach or 70% ethanol.

To reduce the risk associated with hazardous voltage:
e Unplug the RAMP® 200 before cleaning.
e Do notimmerse any of the RAMP® 200 components in water.

e Do not use the RAMP® 200 if there is apparent damage to a power cord or power supply.

ACAUTION

To reduce the risk associated with environmental contamination:

e Dispose of instrument and accessories in accordance with federal, state, and local
requirements.

Do not open any RAMP® 200 device enclosures, this will void warranty.
To reduce the risk associated with incorrect test results:

e RAMP® 200 should only be used by trained professionals and operated in accordance with
facility policies and procedures.

o RESPONSE BIOMEDICAL 12
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UNPACKING & SETUP
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Unpacking and Setup

Inspect all components carefully. If any damage is visible, notify the carrier and your distributor or notify
Response Biomedical Corp. to arrange for repair or replacement.

Shipping container contents

Item Description

RAMP® 200 Control Module (CM) RAMP® 200 Control Module ——
RAMP® 200 User Manual *’;
Power Supply* g vl
USB Flash Drive** S

RAMP® 200 Test Module (TM) RAMP® 200 Test Module
Interconnect cable

"-h.-'.

* Use only the approved power cord provided with the RAMP® 200. A power cord approved for the
North American market is provided with each CM.

**  Use the manufacturer-supplied USB flash drive. If a USB flash drive is supplied by the
User/Operator, ensure that the drive folders match those folders listed in Exporting or printing
Assay result or event log data OR Manually Transferring/Printing Test Results section.

Additional accessories supported by the RAMP® 200 include an optional printer and a barcode scanner.
Only use the approved USB cables that are supplied with the components.

Only one of each type of device can be connected to a CM at any given time.

=% RESPONSE BIOMEDICAL 14
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Optional Components

Item

Description

Printer

Printer
(*Chinese
printing
capability)

Barcode
Scanner
(with cradle)

Barcode printer for self-adhesive roll labels, 2 - 2.5-inches
wide. Connects to the CM via USB. Zebra" Technologies TLP
2824™ or TLP 2824 Plus™.

*NOTE: TLP 2824 Plus™ is compatible with CM V1.3 or
later software only. -'j

Consumables: &3,
o >

Requires 2.25” W x 3” L Z-Select 4000T labels from Zebra® n-;w‘
Technologies (p/n: 800222-305).

Requires 57mm x 74m wax/resin ribbon from Zebra’
Technologies (part number: 800132-102).

Additional information available at www.zebra.com or
phone 1.866.230.9494.

Barcode printer for self-adhesive roll Iab(ils, 2 - 2.5-inches

wide. Connects to the CM via USB. Zebra Technologies

888-TT™.

Consumables:

Requires 2.25” W x 3” L Z-Select 4000T labels from Zebra”

Technologies (p/n: 800222-305). N
Requires 64mm x 74m wax/resin ribbon from Zebra’ - '

t
Technologies (part number: 03200GS06407). 1 ?

Additional information available at www.zebra.com or
phone 1.866.230.9494.

NOTE: This printer is only compatible with CM software
version 1.3 or later. This printer supports printing in
Chinese.

Omni-directional, hands-free barcode scanner for entering

operator and patient/sample ID. The barcode scanner is

shipped in the correct configuration and is ready for use .’

after connecting to the CM via USB. Symbol Technologies H
Inc. model LS9208. Additional information available at
www.motorolasolutions.com, 1.800.653.5350

Unpacking & Setup

=% RESPONSE BIOMEDICAL
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Setup

»  To set up the RAMP® 200 for use

1 Place RAMP® 200 components on a stable work surface within reach of an electrical outlet
(and network connection, if available). Access to the back of each module is required to
connect components.

2 Refer to Figure 2 for connector locations.

Remove the dust protection stickers from TM ports.
Connect the TM and any optional devices to the CM using the supplied interconnect cable(s).
Connect the supplied power cord to the CM. Plug the other end into a wall socket.

HOODN

e Up to three TMs can be connected to each CM.

e TMs can be stacked vertically or horizontally (one on top of
another).

e CM can be placed on top of the TM.

Figure 1:  RAMP® 200 - front view
RAMP® 200 Control Module\(
Touchscreen display |

Test cartridge ports

Lot card
insertion slot

RAMP® 200 Test Modul
(@ maximum of three TMs
can be connected to the CM)

Port LEDs
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Figure 2: RAMP® 200 - rear view

RAMP® 200 Control Modul USB connectors for optional
e\[ \ printer, barcode scanner
and flash drive

Power on/off

Power cord connector
AMP® 200 Control Module
to RAMP® 200 Test Module
/ \ connectors

Ethernet connector

MP® 200 Test Module

ACAUTION

e Do not stack a CM on top of a TM unless all four feet of the CM
rest on the TM housing.
e Do not place anything on top of the CM.

Figure 3: RAMP® 200 Control Module - rear panel label

Power On Power Off  TM ports LISB ports (x3)

xxxx ) y ; / \\_\ I.

Cantrol Module

SN Winma R A

Medel

pee  PIEURN

P _ / Safety and standards labels.
Electrical Rating Ethernet For descriptions, see the Symbals section.
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Figure 4: RAMP® 200 Test Module - rear panel label

Tesl Module

SM HEETEL L ]
1

Model

Rew I Illl'

Hardwware rewision number Serial number
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RAMP® 200 BASICS
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RAMP® 200 Basics

The RAMP® 200 is pre-programmed with default settings so you can use the instrument immediately.
Some settings can be edited manually through the Settings menu on the CM touchscreen. However, you
will find that you can edit most settings using the Reader Configuration Utility (RCU) found on the USB
flash drive supplied with the CM.

2 Refer to Editing Settings Using the RCU section.

Powering On/Off

The power On/Off switch is located on the rear panel of the CM (Figure 2).

To turn the instrument on, press the power switch up. When the power is switched on, the LEDs on the
front of the TM illuminate blue and the RAMP® 200 performs a series of internal quality control (1QC)
self-tests in order to ensure that the system is operating within specifications.

X Refer to Running 1QC Tests section.

When the power-on sequence is complete, the Home screen is displayed (Figure 5). The power-on
sequence takes approximately 1 minute to complete.

To turn the RAMP® 200 off, press the power switch down.

» RAMP'
r"‘..r
= .
L
&
3
)
Run Assay Menu
Figure 5 Home Screen
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Touchscreen

The Control Module is controlled using the interactive touchscreen. Once the Home screen is displayed,
selections can be made by touching the appropriate prompt on the display (i.e., Run Assay to initiate
a RAMP® Test, or Menu to go to the Main Menu) (Figure 6).

The display is pressure/touch sensitive and can accept input from a bare/gloved finger or a blunt stylus.
To complete a task, select the appropriate button, icon, or command by touching it.

In this manual, ‘select’ and ‘touch’ may be used interchangeably.

/N caution

Pens or other sharp instruments will damage the touchscreen.

The Reader Configuration Utility (RCU) can now be used to configure
hospital/clinic preferences.

X Refer to Editing Settings Using the RCU section.

Display Icons

The left-hand column of the screen displays an icon for each available testing port. Selecting these icons
leads to a full screen display of the status information of that test port.

» RAMP
Results
Lac
Log

— flun GG
IJ___,..r-"'“

Saitings

Run Assay Menu

Figure 6 Main Menu Screen

=% RESPONSE BIOMEDICAL 21



RAMP® 200 USER MANUAL RAMP® 200 Basics

The lower left corner of the display screen, below the port icons, displays LQC, printer and

communication warning icons. The description of the displayed icons are as follows:

Icon Description
Port Idle

Port Busy
Assay Timer

Sample Processing and Cartridge Movement

Error Message (HRB is shown for example only)

“*+  For other error messages, refer to Test Run Messages in the
Troubleshooting section

A AAAAL
A

Aborting Assay - cartridge ejecting, error message to follow

Liquid Quality Control — Warning
>+ Refer to Running Quality Control section

=
H
(9]

=2
o
]
0
o
o
(@]
—+
Q
=
o

Liquid Quality Control — Expired Warning
&+ Refer to Running Quality Control section

o)
=
=]
(5]

(Non-selectable)

Printer Error

>
Iy

(Non-selectable) 2 Refer to Printer Errors in the Troubleshooting section

—— Data Transffar Error
2+ Refer to Printer Errors in the Troubleshooting section

>

(Non-selectable)

Test Port Identification

Test ports on the RAMP® 200 are identified by a multi-character label. The first set of characters is the
serial number of the TM; the second character is a location letter (A or B) referring to the left (A) or right

(B) port for a particular TM. This is displayed when a port icon is selected.

=% RESPONSE BIOMEDICAL
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PERFORMING A RAMP® TEST
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NOTE

For U.S. customers, the RAMP® 200 must be operated in a laboratory
setting when used with the RAMP® Cardiovascular Tests.

ACAUTION

When entering data via the CM touchscreen (e.g.,
Sample/Patient/User ID), enter characters one at a time. Failure to do
so may result in erroneous data entry.

/N caution

Be familiar with all information in the RAMP® Test Kit Instructions for
Use (IFU), including Warnings & Precautions prior to running a Test.

A WARNING

Operator Hazard.

Observe local protocols and appropriate precautions in the collection,
handling, and disposal of specimens.

Using Lot Cards

Prior to performing any Assay, the Lot Card for that RAMP® Test Kit lot must be read by the RAMP® 200
through insertion into the Lot Card slot (Figure 1). The Lot Card provides lot-specific information and the
expiration date for each Test Kit and is only required to be read once for each Test Kit lot. The CM can
store information from 50 different lots. If the maximum is exceeded, the oldest entry is overwritten.

Neap=

The RAMP® 200 can only accept a Test Cartridge that is designed and
specified for use with a RAMP® Test Kit.

ACAUTION

Do not touch the contact pads on the Lot Card.
Store the Lot Card in the anti-static pouch that is provided with the
RAMP® Test Kit.
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»  To use the Lot Card

1 Hold the card so that the arrow is on the top side and pointing away from the user.
2 Insert the Lot Card — contact end first — into the slot located on the front of the CM.

3 The display provides the following status messages:

Reading Lot Card
Complete

Lot ID: MOXXXX
Remove Lot Card

Note: The Lot ID displayed is the lot number of the RAMP® Test Kit.

4 Remove the Lot Card and store in its original pouch.
= If the screen displays an error message, or if there is no response to the Lot Card
insertion, refer to the Troubleshooting section.

5 Keep the Lot Card for the life of the Test Kit.

Starting an Assay

The default setting of the RAMP® 200 does not require an Operator ID
or Password. These requirements can be edited via Edit Operator in
the Settings menu or the RCU. If using the RAMP® 200 with default
settings, Figure 7 will not appear.

If the following Liquid Quality Control warnings Nl ALQC appear:

> Refer to LQC icons in Quality Control section for instruction on how to proceed.

If a Test Cartridge is inserted and the Lot Card data is not stored in the
CM, the Lot # XXXX Not Found, Insert Lot Card or Cancel message will
be displayed. The Lot Card must be inserted within 40 seconds or the
Assay is aborted. Select OK to return to the Home screen.

»  Torunan Assay

1 From the Main Menu screen (Figure 6) select Run Assay. If prompted, enter Operator ID
and/or Password (Figure 7) using either the touchscreen or the barcode scanner. To accept
the displayed information, touch Accept.
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Operator Entry “RAMP’
Dparator I Cloar
Pazsword Clear

8)o)le]

‘f o] P

r..--’" '

- £ X E v B N . <

Al Kays Cancal

Figure 7 Operator Entry Screen

NOTE

e The Operator ID and Password entries are case sensitive.

e The CM supports Pinyin character entries only. If the CM is set to
Chinese language, ensure that the Operator ID and Password are
set up using the English alphabet (primary keyboard) and the
English character set (select M).

2 When prompted, enter the Patient ID/Sample ID using either the touchscreen or barcode
scanner (Figure 8). The maximum number of alpha or numeric characters for the Sample ID is
18 characters. To accept the displayed information touch Accept.

Patient ID Entry: * RAMP’

Patient ID Clear

A

T

H
(,,,-— F
(_,.«— Al Keys Shift

Figure 8 Patient/Sample ID Entry Screen
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For detailed instructions on how to handle samples, refer to the
RAMP® Test Kit IFU.

3 When the display prompt to Add Sample & Insert appears, the LED on a free port of the
TM will flash blue and the corresponding icon ﬁ on the display will illuminate blue.

4 Prepare the sample and Test Cartridge as specified in the Test Kit IFU and firmly insert the
cartridge into the flashing port.

Do not use excessive force when inserting the Test Cartridge. Once inserted, the TM will
automatically guide the cartridge into position for analysis.

Nea=

e The Test Cartridge must be inserted into the TM within
approximately 30 seconds of sample application; otherwise FAIL
will be displayed in the port icon and the system will abort the
Assay.

If the Test Cartridge is not inserted within five minutes of the Add Sample & Insert display
prompt, the instrument will time out and return to the Main Menu. Touch OK to return to
the Main Menu.

5 Once the Cartridge Inserted message clears, the display returns to the previous screen and

the active port icon shows a timer that counts up until sample flow is detected by the
RAMP® 200. The timer then counts down until the RAMP® Test is complete.

Another Assay can be started once Assay Initialization is complete,
and screen returns to Main Menu, by selecting Run Assay.

6 While the Assay is in progress, touching the port icon will show details of the Assay
progression status and an Abort Assay option.

Selecting Abort Assay will eject the Test Cartridge and the RAMP® 200 will record the Test
as a Failed Assay in the system Events Log.

To return to the previous screen, touch Exit.

7 When the Assay is complete, the Test Cartridge is automatically ejected and the

corresponding port icon will display . To view the Test details, touch the icon for that
port prior to physically removing the Test Cartridge.
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Nea=

Before removing the Test Cartridge fully from the TM, a predefined
note can be added to the result from the drop-down menu in the
Result Details screen (Figure 9). Once the Test Cartridge has been
removed, a note can no longer be added or changed.

You can add up to 10 predefined notes using the RCU.

L]
k" Refer to Editing Settings Using the RCU section

Port 3A: “ RAMP
Port S/N: BOOGSE-A
Datw/Time: 3008-12-04 074328
Patient ID: Tnl
Assay: Tnl
Result: 0.37 ng/mL In Range
Mormal Range: 0.00-100.00ng/mL

rator; [Nems
= e Opeesen, I8
ER
r_‘__,__. Haternity
" Rapeai Test

Run Assay Menu

Figure 9 Results Detail Screen Prior to Cartridge Removal

8 Remove the Test Cartridge from the TM test port.
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QUALITY CONTROL F
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Two types of quality control Tests can be run and stored by the RAMP® 200:

2+ LQC (liquid quality control): external surrogate samples used for routine QC testing.

2+ 1QC (internal quality control): self-diagnostic test that include a check of the power supply
voltage, system memory, cartridge transport system, cartridge barcode sensor, optical
function, and incubator function for heated Assays.

LQC is disabled in the default settings of the RAMP® 200. It must be
enabled and configured through the RCU.

Running LQC

» TorunanLQC Test

1 From the Main Menu screen (Figure 6) select LQC. The LQC — Assay List screen is
displayed (Figure 10).

LOC - Assay List = RAMP
! ~ Assay | LOCExpimfion | Tdfé'a?aiﬁ'_|
i'l [T 1 |8 v
!E [ VIR darn | i} |
i: (TR Pl ) S i)
!4 Tal EET Ry} s |
Run LOC Menu
Figure 10 LQC — Assay List

This screen will display the entire Assay list sorted in alphabetical order. If LQC is due, the LQC Expiration
column will display ‘Run x of y levels’, where x is the number of levels required and y is the number
of LQC levels that have been defined for that Assay in the RCU.

The LQC Status column displays the requirements for any LQC levels that have failed. If any LQC fails,
that specific control level must run successfully prior to proceeding with a patient Test.

If the maximum number of failures (as defined for the Assay in the RCU) is reached; an ‘Assay Lockout’
and ‘LQC Lockout’ message is displayed.

The Assay List is defined in the RCU. Any new Assays set up in the RCU
will default to LQC disabled and the timers will be listed as N/A in the
LQC Expiration column.
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2+ Refer to the RCU Help Manual for more information.

2 Select the Assay for which LQC will be performed. Touch Run LQC, located at the bottom of
the screen. If prompted, enter the Operator ID and Password (Figure 7), if required, using
either the touchscreen keyboard or the barcode scanner. To accept the displayed information,
touch Accept.

The Operator ID and the Password are case sensitive.

3 If prompted, select the appropriate Control ID using the drop-down menu (Figure 11). Touch
Accept.

Control 1D Enlry: = RAMP

Pass 2 ol & levals,

Selecl Conlrol for Azsay: CK-MB

L-1: QUANT1 [PASSED]

L-1: GUANTY [FABSED)
L-2: QUANT? [FASSED]

L-3: CHIANTS [PASSED
.f"'f.._ L-4: QUANTS Epnssm{
L-5: QUANTS [FASSED]
.".H..F Cancal Accapt
Figure 11 Control ID Entry Screen

NOTE

® |f LQC has failed for the selected Assay, the maximum number of
LQC attempts before Assay lockout is displayed.

® |f an Assay is locked due to failed LQC attempts, then the LQC
timer must be reset through the RCU.

4 When prompted to Add Control & Insert the Test Cartridge on the display screen, the LED
on a free TM port flashes blue and the corresponding icon ﬁ on the display will illuminate

blue.
> Refer to the RAMP® Test Kit and quality control IFUs for more information.

5 Prepare the sample and Test Cartridge as specified in the Test Kit IFU and firmly insert the
cartridge into the flashing port.
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Do not use excessive force when inserting the Test Cartridge. Once inserted, the TM will
automatically guide the cartridge into position for analysis.

e The Test Cartridge must be inserted into the TM within
approximately 30 seconds of sample application; otherwise FAIL
will be displayed in the port icon and the system will abort the
Assay.

If the Test Cartridge is not inserted within five minutes of the Add Sample & Insert display
prompt, the instrument will time out. Touch OK to return to the Main Menu.

6 Once the Cartridge Inserted message clears, the display returns to the previous screen and
the active port icon shows a timer that counts up until sample flow is detected by the
RAMP® 200. The timer then counts down until the RAMP® Test is complete.

7 While the Assay is in progress, touching the port icon will show details of the Assay
progression status and an Abort Assay option.

Selecting Abort Assay will eject the Test Cartridge and the RAMP® 200 will record the Test
as a Failed Assay in the system Events Log.

To return to the previous screen, touch Exit.

Selecting Run Assay or Run LQC will start another Assay/LQC and the
Test sequence will begin again using a different available port. The
Assay progress can be checked by touching the port icon. Touch Exit to
return to the previous screen.

8 When the Assay is complete, the Test Cartridge is automatically ejected and the

corresponding port icon will display

To view the Test details, touch the icon for that port prior to physically removing the Test
Cartridge.

9 Remove the Test Cartridge from the TM test port.
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LQC Icons

Icon Description

LacC Indicates that LQC is due shortly. Appears when the LQC timer for an Assay has less
than the user defined % of time remaining until Assay lockout.

ALac Indicates that the LQC has expired for one or more Assays. If icon is displayed, the
Assay Status Warnings screen (Figure 12) will display upon touching Run Assay.
Select the desired Assay and touch Continue.

A limited number of overrides can be configured via the RCU (Figure 13). If overrides
are available, select Continue to override the lockout (i.e., perform a patient Test
after LQC is due). The decision to use an override must be confirmed by touching Yes
when prompted.

Once all overrides have been used, LQC must be performed prior to any further
patient testing. If an Assay with no remaining overrides is inserted into the TM, the
status message LQC Required, Assay Aborted. Ejecting. is displayed, the Assay
is aborted and the Test cartridge is ejected.

= RAMP’
Assay Status Wamings
Assay Status gx:;;
1 oM g Expered z
2 e L Eapered
3 WP L Bagered 1
4 ol L Expared )
/ Continue Cancel
Figure 12 Assay Status Warnings Screen
* RAMP’
LQC Due. Override or Cancel
Test Name Tl
Overrides Remaining 4
Ovarride LQC Expiration?
/_ Yes No
Figure 13 Override Confirmation Screen
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NOTE

If there is more than 1 level of LQC defined for an Assay, and LQC has
expired for this Assay, the LQC timer is reset to the time at which the
earliest LQC level passes in the set (e.g., if 2 levels of LQC are required
and Level 2 passes LQC but Level 1 fails, Level 1 must be repeated and
pass). The ‘Time to Expiry’ column in the LQC menu will display the
count down from the time when Level 2 passed.

Running IQC

An 1QC Test runs automatically every time the RAMP® 200 is powered on. IQC can also be initiated
manually or configured to run automatically at predefined intervals using the CM

- See Edit Settings or see Editing Settings Using the RCU sections.

»  To runan IQC Test manually

1 From the Main Menu screen (Figure 6), select Run IQC. The IQC Status screen is displayed
(Figure 14).

IQC is started on all idle ports and will automatically start on other ports as they become free.

= RAMP

3G Started On AH Ports

r__,_,.r"'_
r_.-_,..v-"'_

Figure 14 1QC Status Screen

2 Touch OK to return to the Main Menu. If 1QC fails, the TM port LED illuminates red, the port
icon turns red and access to the failed port is prevented.

To schedule 1QC Tests to run at predefined intervals, the Test times
must be configured using the CM.

>+ Refer to Timer Tab section in View Screen Tab settings.
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WORKING WITH RESULTS
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Data Management Guidelines

The RAMP® 200 can store up to 900 results:
e 300 patient results, maximum
e 300 LQC results, maximum
e 300 1QC results, maximum

When the CM database is full, the oldest result is overwritten. Dual analyte Assay results are stored as
two separate records. IQC results are stored separately for each individual Test port.

In manual transfer mode only (i.e., when the instrument is not connected to a network), the warning
‘Database Almost Full, Backup Data’ is displayed when there are less than 20 LQC or patient result
spaces left in the database. This message will continue to be displayed until the database has cleared.

When the instrument is in auto transfer mode, only new results that have not previously been uploaded
are transferred during the upload. Data is not deleted from the CM upon transfer.

Prior to deleting results, transfer and store all data in accordance with
applicable local, state and/or federal guidelines or accreditation
requirement and each facility’s protocol.

Viewing Saved Assay Results

»  To view saved Assay results

1 From the Main Menu screen (Figure 6), select Results. A list of all Assay Results is
displayed (Figure 15) in reverse chronological order, with the most recent results at the top.

fszsay Results T RAMP'
, Anany Results LOC Results 10C Aesults
7} (4} (22}
[Pationt 1D Assay Mame  Hesult DsteTime |
- e LU L L Rl Al e
wa RN — P p——
L] Tl 47 ngind TR R
ar O - ki il el b LRI BE -]
- [T ey - S A
r__.-""" £ £ i 3 -0
o ot g R p—
r.-""'.._\ Saarch rareai Salact AR
Run Assay Menu
Figure 15 Assay Results Screen
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For each Assay result, the Patient ID or Sample ID, Assay name, result
value and date/time is displayed.

2 To view a list of LQC or 1QC results, touch the circle next to the words LQC Results or IQC
Results (in the display header) to specify the type of results to be viewed. The list of results
will be displayed.

3 To view the details of a particular result, select the result and then touch View (Figure 15).
The Results Detail screen is displayed (Figure 16).

Results Detail  RAMP
Port SM: BOOTGIT-A
Data/Time: 2008 -10-21 01844
Patient ID: R1
Assay: Myo
Result: 184.1 ng/mL in Bango
MNormal Range: 0.0-+infng/mL

HMate: Mo Motes Recorded

(-"'"H Operator:
Lot: 352 (2010-01-31}
r--"""— Pegults List
Run Assay Menu
Figure 16 Results Detail Screen

4 To print the result details, touch Print. Touch OK to return to the result details. To return to
the result list, touch Results List.

Viewing Event Logs

» To view event logs

1 From the Main Menu screen (Figure 6), select Log. A list of all recorded Events will be
displayed (Figure 17), with the most recent event listed first.

For each event, the screen displays the date/time. Events include
system power up, upload/download of data and Assay and LQC
failures.
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All Evenis > RAMP
8 All Events Fuilad Asasys Fuiled LOCs
(20} i) @)
L BERTENTE T e . =
=1 e W b T e l
| 1 T bl g T e
.a.- 1 EET. P Erugs g b 5 Dk 1w

TR 1T AN Aervary alarl - Tevsssd ey b (ol Carvd Do
I?_-II-H'“TI'U Wyaims mawan) S verien b 0K

r”r TR AT riviem) Se——— O

- BFE LA W PR SR e LR
w 1L Senreh Tranvad Select AN Vi
Aun Assay Menu
Figure 17 All Events Log

2 To view a list of failed Assays or LQCs, touch the circle next to the words Failed Assays or

Failed LQCs (in the display header) to specify the type of results/events to be viewed. The
list of events will then be displayed.

3 Toview the details of a particular event, select the event and then touch View.

4 To return to the event list, touch Events List.

Searching for Assay Results

The following table describes the available search option combinations you can use.

Result type Search option Search option Search option
Assay Operator Name Sample/Patient ID Assay Name
LQcC Operator Name Control ID Assay Name
1QC _ Operator Name Port

»  To search for Assay results:

1 From the Assay (or IQC or LQC) Results screen, touch Search to open the Search
Assay Results screen (Figure 18).
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Search Assay Results = RAMP
Operator Name -
« All Results
Date Rangu
Q W E T Y
H
SBea ae
AR. Kays Cancel Search
Run Assay Menu
Figure 18 Search Assay Results Screen

2 To change the search parameter, use the drop-down arrow w on the Operator Name: and
select the new parameter.

3 Use the touchscreen keyboard or barcode scanner to enter/scan the desired value to search.
Touch Alt. Keys ‘ or Shift ‘ to display an extended character set.

Enter the first few characters of the name or ID you are searching for.

4 To filter the results, touch the circle beside either All Results or Date Range. All Results
is the default setting. When Date Range is touched, the From/To Y M D fields become
active. Enter the desired dates in the format: YYYY MM DD.

5 To generate a list of results based on the search criteria entered, touch Search. Touch
Cancel to clear the search criteria and return to the main Results screen.

If nothing matches your search, the screen displays the message Empty Search.

6 To return to the complete results list, touch View All.

Searching for Events

Follow the directions below for searching the Assay results.

Event type Search options

All events Operator Name Event Text (enter any part of field, not case-sensitive)
Failed Assays Operator Name Sample/Patient ID | Assay Name

Failed LQC Operator Name Control ID Assay Name

=% RESPONSE BIOMEDICAL 39



RAMP® 200 USER MANUAL Working with Results

Manually Transferring / Printing Results or Logs

Analysis results can be viewed on the RAMP® 200 display screen, exported/transferred to a USB flash
drive, computer or network server, or printed out from the CM. Event logs other than failed Assay and
LQC cannot be printed from the CM, however they can exported to a USB flash drive, computer or
network server.

It is important to note that the user should manually delete the results from the instrument after
manual transfer or they will be transferred again, unless a specific range of results is selected when the
next manual transfer is performed.

A USB flash drive can be used to transfer results and logs from multiple
instruments as the Result and Log file names start with their respective
CM serial numbers.

ACAUTION

The USB flash drive should not be removed from the CM while data is
being transferred.

NOTE

The USB flash drive must be pre-configured with four (4) file folders
named: patient, Iqc, iqgc and log for this use. Verify that the USB flash
drive included with the RAMP® 200 includes these folders, or should a
personal USB flash drive is used, the folders are added prior to
transferring results and logs.

»  To manually transfer/ export or print result or event log data

1

From the Assay Results screen (Figure 15) or the All Events screen (Figure 17), select the
desired records to be exported. Touch Transfer to open the Results: Transfer (Figure 19)
or Events: Transfer screen.

Touch Print, USB or Network depending on the data output option desired. Only the
options for which the connections are available will be functional.

Confirm the transfer by touching Confirm. Touch Cancel to abort the transfer (Figure 20).

When the transfer is complete, touch OK and the prior screen will be displayed. If the transfer
fails the warning icon and a failure message are displayed.

Touch OK to return to the Assay Results or All Events screen.
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If the CM is set to Chinese, the 888-TT printer must be used for printing
results in order to print the Chinese characters correctly.

Results: Transfer > RAMP
r""'hn Patient ID| As=ay Nama| Rosull | T

HEgelnEE WEpAE

r_,..a-"‘- REERS, 2

by 4 g
("’-_ e b bre
[0 ¥4 o
("’r | BT
== : Confirm Transfer To USB
| Canfirm | Cancal
Figure 19 Results Transfer Screen
Results: Transfer = RAMP
Selected Resulls Shown

Pabienl 1D Assay Name Result | DateTime

r.....'-.- Select Results Destination

("!“ USE | Matwork Print | Cancel

Figure 20 Results Transfer Confirmation Screen

Converting Exported Data to Excel Format

Once results have been exported, the File Converter Utility on the supplied USB Flash Drive may be used
to convert the data files to Excel format.

» To convert the data files to Excel format:

1 Insert the supplied USB Flash Drive into a computer. Located and open the “File Converter.xls”
version 1.1 or greater.

2 In Excel, enable macros and follow the directions on the screen.

3 Excel will prompt the user to save the file in an Excel format.
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Many features of the RAMP® 200 are not available until a user with Supervisor privileges has configured
them on the CM, or until a Full Access user has configured them with the RCU.

¥ See Edit Settings
> See Editing Settings Using the RCU

Customizable features include operator IDs and passwords, data transfer options, print options, display
language (only on the CM), network settings, LQC timers and ranges.

A few of these settings may be edited using the RAMP® 200 touchscreen. Most settings can be edited
using the RCU.

Feature Full Access User Supervisor
(detailed descriptions to follow) (edit on the RCU) (edit on the CM)
Assay defaults v

LQC v

Update / upload features v

Printer settings v

Login requirements v V (limited)
File settings v v
Menu idle / timeout v
Date / time (without network time protocol — NTP) NTP only \'
Language v
Auto 1QC interval \4 v
Network transfer timers '
Sound v

IP address v
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Accessing the Settings Menu

From the Main Menu (Figure 6) touch Settings to display the Settings menu (Figure 21). The
Settings menu requires an Operator ID with Supervisor access privileges.

The default login for access to the Settings menu is:
Operator ID: SUPERVISOR
Password: PASSWORD

Both entries are case-sensitive. It is highly recommended this login be changed after the RAMP® 200 has
been installed.

; _-S-;IIinga i _ RAMP"
:_ View Settings Import Canfiguration
r,,---" Edat Saltings Expor Cornfiguration

|
(__,,.-— Edit Oparators Dalete Rosults
="
Rastors Defauks Upgrade
=
Fun Assay Menu
Figure 21 Settings Menu

View Settings

To view the configured settings for the RAMP® 200, touch View Settings from the Settings menu
(Figure 21) and the Settings: View screen (Figure 22) will open. The Settings: View screen features a
series of tabs that display the current instrument settings. Select a tab to view the settings.

Setlings: View > RAMP
Assay LOQC Timer Printer Login @ File About
3 be [ Patient I Hew Assaxy Lockout
Fiold Title:  Pationt ID ek B N
Min Length: 1
Max Langth: 18
Predefinod Hotes

Menu
Figure 22 Settings: View Menu — Assay Tab

2 For complete information on individual tabs, see Settings: View Screen Tabs section.
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Edit Settings

To edit the configured settings for the RAMP® 200, touch Edit Settings from the Settings menu
(Figure 21), login as described in Accessing Settings Menu section and the Settings: Edit screen (Figure
23) will open.

The Settings: Edit screen features a series of tabs that include editable instrument setting fields. Use
the tabs to select those settings to be changed. Select the appropriate tab, use the touchscreen
keyboard to enter or change field values, then touch Save.

When in the default settings configuration only a Supervisor can access
the Settings menu.

Settings: Edit *RAMP
Timer | File DateTime Language Misc. IP

15 interval {minutes) 0
Manu Idle Timsout {minutes) |5

AR, Kays Hhelh Haswl Cancal Bwve

Figure 23 Settings: Edit Menu — Timer Tab

On all Settings: Edit dialogs:

® Use the touchscreen or dropdown lists to enter/select the desired settings.
Touch Save to save your settings.

Touch Cancel to return to the previous screen without saving your changes.

Touch Reset to undo entry and return to the default setting.

Touch Alt. Keys |or shift | to display extended characters (available characters will vary depending
on language setting).

> For complete information on individual tabs, see Settings: Edit Screen Tabs section.
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Restoring Defaults

Restoring device settings to factory defaults erases all stored settings, Assay results and operator
information.

NOTE: Back up all device databases before you restore the system settings to the default values.

To restore the system defaults:
1 Select Menu > Settings > Restore Defaults. The Settings: Restore Defaults screen appears.
Seltings: Restore Delaults » RAMP

| Al Daiabases Wil Bs Crasned
Back Up Files Al Settings: Expon Configurstion

System Will Nosd To Ba Restartad Following
This Procedurs

Aeetore Delaults Cancal

Select Restore Defaults and then select Confirm.
At the prompt, turn the RAMP® 200 off and on. The system completes the restoration of the defaults.

Managing Operators

If an operator ID or password is required, only individuals with operator IDs stored on the RAMP® 200
can perform Assays. The operator login requirements can be set on the CM and RCU.

Accessing the operator management fields

To manage operators:

1 Select Menu > Settings and enter the operator ID and password. The default login for access to
the Settings menuis:

Operator ID: SUPERVISOR
Password: PASSWORD

NOTE: Both entries are case-sensitive.

From the Settings Menu (Menu > Settings), select Edit Operators.
The Settings: Operators screen appears.
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=i |||
DOpsrstor Login Requiremants  Nons
r.-""-' = Search Maxdity View
Menu
A complete list of all operators authorized to use the device with Display Name and Operator
Type appears.
Operator and supervisor access privileges can be defined using the RCU only.

Defaults: Operators = Run Assays, Supervisors = Run Assays and change settings (see Managing
operators on page 46).

To view detailed information for an operator, select the operator’s entry and select View.
Settings: Operator: Details * RAMP

Operator |0: SUPERVISOR
Display Mama: Doafaultllsar
Type: Supsrdsor
Expiration Data; Mo Expiration

=
fﬂi’_ Delete Operator Operator List
Menu

To modify an existing operator, select the operator’s entry and select Modify (the Add button changes

to Modify).
To add a new operator, select Add when no operator entry is highlighted.
To search for a specific operator, select Search (see Searching for an individual operator on page 48).
To delete an operator, select Delete Operator while you are viewing an operator’s details.
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Adding or modifying an operator

To add or modify an operator:

1 If you are adding a new operator, complete all desired fields in the Settings: Operators: Add
screen (select Menu > Settings > Edit Operators).

Settings: Operators: Add “ RAMP"
Operator ID Dparstor Type Operator
Diaplay Mame |

NOTE: The RAMP® 200 can store a maximum of 600 operators.

If modifying an existing operator, the screen title is Settings: Operators: Modify and the fields
are populated.

Operator ID: Characters entered to access the RAMP® 200 (maximum length 18 characters).

Display Name: Characters displayed with results for this operator ID (maximum length 50
characters).

NOTE: Although 50 characters may be entered in the Display Name field, it is truncated on the
CM display and result print out. The full 50 characters will only be visible in the Edit Operators
screen in the Settings menu or through the RCU.

Password: Maximum length 18 characters.
Verify: Re-enter the password.

Expire: Date that the operator’s permission to use the RAMP® 200 expires. Operator is locked out
after that date. To disable the expiration feature, leave the field blank.

Use the w drop-down arrow to select the desired Operator Type: Supervisor or Operator.
Select Accept, and then select Confirm.

Searching for an individual operator

Use the Settings: Operator: Search screen to select operators by the following attributes:

Operator name
Operator ID
Expiry date
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Settings: Operator: Search > RAMP

Operstor Nams
& ANl Dparators

To search for a specific operator:
> Define who you want to search for:
In the Operator Name drop-down select the desired name or ID you want to search. To disable
expiry date fields for searching, select All Operators.
To search for operators whose permission to use the system expires in a given date range, select
Expiry Date and then enter the date range. The default value is the current date + 10 years.

Select Search.
(Optional) To return to the main list of operators, select View All.

Importing Files
Device settings, including operator lists from the RCU or another RAMP® 200, can be imported using the
USB flash drive.

To import files:
2 Click Menu > Settings > Import Configuration. The Settings: Import Configuration

screen appears.

Setlings: Import Conliguration % RAMP'

Select Files, Press Transier
 FileMame  Size(bytes))  Dats
P —— - 0 e
P e ] - T
st s T L BTRT TS
|y Sty £ 1D TR
S o 0

wrater Cancal

Select the files you want to import and then select Transfer. Transfer is indicated by blue circles across
the bottom of the screen.
Select OK when the transfer is finished.

NOTE: If the import fails, the warning icon appears. For troubleshooting tips, see
Troubleshooting, starting on page 62.

49
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Exporting Files
Exporting files allows back-up of critical RAMP® 200 information including configuration files, operator
lists and result files. Whenever you relocate the system, use the export feature to back up your data.

To export files:
2 Click Menu > Settings > Export Configuration. The Settings: Export Configuration

screen appears.
Settings: Export Configuration + RAMP’

Export the following files to the External USB Drive:
Dovice Information File
DevicaSettings
Group Settings
Assay List
Confrol List

Oparator List
All Result Files

Evert Log File
Debug Log File

Export to USE Flash Drive Cancal

Select Export to USB Flash Drive.

& CAUTION! The flash drive must be pre-configured with four subdirectories (folders). These must
be named: patient, Iqc, igc and log (case sensitive).

Transfer is indicated by blue circles across the bottom of the screen. Eleven files are transferred.

A Transfer Complete notification appears when transfer is finished. Select OK to return to the
Settings menu.

NOTE: If the import fails, the warning icon appears. For troubleshooting tips, see
Troubleshooting on page 62.
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Deleting Assay Results

NOTE: Prior to deleting results, transfer and store all data in accordance with applicable local, state
and/or federal guidelines or accreditation requirements and each facility’s protocol.

To delete Assay results:
- Click Menu > Settings > Delete Results. The Settings: Delete Results screen appears.

Settings: Delete Resulis > RAMP
Dalate Results Prior to Dats
Dialsts &l Fasits
Cancal

Select Delete All Results or Delete Results Prior to Date.
Select the Assay results you want to delete:
To delete all of the Assay results, select Delete All Results and then click Confirm.

To delete the results prior to a specific date, select Delete Results Prior to Date. The Delete
Results Prior to Date screen appears.

Setlings: Delete Resulis = RAMP
Detata Aasulls Frior o Dete

Date Year 2008 Maonth 10 Day ||

Cancal

Use the touchscreen keypad, enter the desired date in the Year, Month and Day fields, and then select
Confirm. The confirmation screen appears.

Click OK to return to the Settings menu.
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Editing Settings Using the Reader Configuration Utility
(RCU)

The RCU is a Windows (2000/XP/Vista) application you can use to manage a range of RAMP® 200
features.

Installing the RCU

You must have the necessary login privileges to install software on your computer.

To install the RCU:

1 Insert the RCU USB key into an available USB slot.

2 Open the USB drive.

3 Click InstallRCU.bat located in the root folder of the USB drive.
4

Follow the on-screen prompts to complete the installation.

How the RCU works

The Reader Configuration Utility (RCU) allows you to set up Readers according to the needs of your
institution. The RCU stores this setup information in a set of Reader configuration files. Each group of
one or more Readers has its own directory containing a set of configuration files that define how the
Readers in that group operate. These files include Assay lists and settings, LQC lists and settings and
operator lists and settings.

NOTE: More than one group can share the same Assay list, control list and/or operator list. You can set
the list locations to the same directory for each group or save a list in multiple directories.

In a network environment, you can configure Readers to check their assigned group directory
periodically for configuration changes. In addition, you can configure Readers to send new results and
log information to a network directory.

In non-networked environments, you can use a portable USB flash drive (supplied) to download the
configuration files to the Reader and gather result and log files from the Reader. In order to ensure safe
archive/restore functionality, it is recommended that you use a separate USB flash drive for configuring
each Reader group.

Complete instructions on the use of the RCU are in the RCU program under HELP, or from the START
menu click All Programs > Reader Configuration > Reader Configuration Manual.
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Getting Started with the RCU

To run an RCU session:

Editing Settings

1 Open the RCU from the START menu: Click START > All Programs > Reader Configuration >

Reader Configuration Program.

Login to the system. When the RCU is initially installed, the case sensitive default login is:

User ID: Supervisor

Password: password

Changing the Default Login

To ensure that only authorized users access the RCU, you can and should change at least the password as

soon as you install the application.

To change the default login:

1 Select the Settings menu. The Reader Configuration: System Settings screen appears.

T Reader Configuration: System Settings
e &

Lists Reports SR Help

Readar Configuration Litiity Acoounts

e OveaoD | SRR =
e <y
- Account Mame SUpSryisor
Password password
Privilege O Limited Access (@) Full Access

e Account ] Pelete Account

In the Reader Configuration Utility Accounts section change the values for the Operator ID,
Account Name and Password fields and then click File > Save.

You can also add new RCU user accounts from this screen. User accounts can be set to Limited

Access or set to Full Access.

Limited Access: users can only access the Controls Editor feature
Full Access: users can access all features in the application

See the RCU Help for information on adding / editing and deleting users.
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Resetting the Password in an Emergency

If you forget your password, you can temporarily reset it to allow access to the encoded password list.

To reset the password in an emergency:

1 Inthe User ID field of the RCU Login screen type override and then click Login. A message box
appears and prompts you to contact Technical Support with a five-digit number (Permit #).

Contact your Technical Support Representative to receive an override number.

Enter the override number into the Password field and then click Login (if you enter it incorrectly, you
can re-enter it and try to login again). The RCU gives you temporary access to the Settings screen,
where you can view the user list and passwords.

Restoring the Supervisor Operator ID/Password

By default, only a supervisor with a correct ID and password can access the Settings menu. If the
password is lost and login fails, the user can override and access the Settings menu.

To restore the supervisor operator ID/password:

1 From the Operator ID Entry screen (Menu>Setting>), in the Operator ID field, type
OVERRIDE and then select Next.

The Password Override screen appears and prompts you to contact Technical Support with the
displayed permit number.

Password Override = RAMP
Call Technical Support With Parmil Humber
Ertar Overrids Coda
Parmit Mumber: 62367
Dwarride Code; Clear

1lz]s
4)5] 6
TH 8 9
—~ B
f".’r Cancel cHy

When you contact Technical Support, they will provide you with an override code.

In the Override Code field, use the touchscreen keypad to enter the code and then select Accept.
The CM verifies the code and restores the factory default: Operator ID = SUPERVISOR, Password =
PASSWORD.

Select OK. The screen returns to the Settings menu.
Select Edit Operators. The Operators screen appears.
In the operator list, select Default user with operator ID: SUPERVISOR.

Select Modify to change the following fields if necessary: Operator ID, Display Name, Password
and Expiration Date.
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Accessing Configuration Files

A group is defined as a common configuration shared by multiple Readers. As many groups as necessary
can be defined. Each group must have its own directory. A directory contains a set of configuration files
that define how the Readers in that group operate. For example, one group may be defined for Readers
in an emergency department environment with files saved in a directory ED, while a separate set of
configuration files, for use in an intensive care setting, would be defined in the group ICU and saved in a
directory ICU.

A default group directory (C:\Program Files\Reader Configuration\) is set up during software installation.
If only one group is needed, the initial files can be modified and saved in this directory.

If more than one group is needed, copy the default folder and re-name or use the Save As command to
save all files to a new directory. Each new folder must contain the following files: Assays.dtv, controls.dtv,
grp_settings.dtv, and userlist.opl.

If you export files by USB, you must copy all files in the group directory to the root directory of the USB.

& CAUTION. Do not change the file names.

To open all files for a group:
1 Click File > Open Group.
Select the folder that contains the files you want to use.

Click OK. If you only use one group, the default location is C:\Program Files\Reader Configuration\. This
opens the following files: Assays.dtv, controls.dtv, grp_settings.dtv, and userlist.opl.

To open an individual configuration file:

If you only need to modify one configuration (for example, when you update operator lists), you do not
need to open all of the group files. You can open just the file to be changed (in this example, userlist.opl).
To open the file:

1 Click File > Open.

Select Defaults..., Network... or USB Device.... The File Open screen appears. Use this to navigate
to the drive that contains the files you want.

To select different types of files to load:

1 Select the Files of type: drop-down list. When you select one of the file types, the system lists all
the matching files in the selected directory.

Select the file you want and then click Open.
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Setting up Communications Between RCU and Readers

To set up communications between RCU and Readers, open the default Group Settings file in the RCU.

Files Tab

This page sets the file locations where the Reader(s) looks for specific configuration information. The
Reader supports the following file transfer protocols: HTTP, HTTPS, FTP, FTPS and CIFS. Directories are
specified in URL notation. Consult your IT administrator for guidance on how to use these settings in the
local network environment. If Readers use the USB flash drive for configuration information, you should
set all file location fields to: file:/// as in the default settings (except for time server, which should be
blank).

The system supports the following configurations:

USB Flash drive: file:///

Web Server: http://medsvr/RAMP200/
Network drive: ftp://fileserver/RAMP200_share/
CIFS Share: cifs://fileserver/RAMP_200_share

NOTE: When using CIFS, each directory named must be an explicitly shared CIFS directory and the URL
must not contain a trailing slash.

When using Static IP mode, in order to designate servers by name, you must define a DNS server and use
fully qualified domain names (format server.domain.tld, for example, myserver.mydomain.local).

Files Tab Fields

Field Description

Group Directory Identifies where the Reader(s) looks for all group specific information.

Assay List Identifies where the Reader(s) looks for its list of supported Assays.

LQC Controls List Identifies where the Reader(s) looks for its list of LQC controls.

Operator Accounts List Identifies where the Reader(s) looks for its operator list.

Results Directory Identifies where the Reader(s) places exported result files. In a networked environment,

one or more groups can share the same destination directory.

Device Directory Identifies where the Reader(s) should read and write device specific information. This is
typically set to the same directory as the Group Directory.

Time Server Location Allows the Reader group to access an NTP (Network Time Protocol) server to keep the
Reader's internal clocks set to the correct time. This field should be left blank in non-
networked environments or networked environments that lack access to an NTP server.
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Identifying Readers Through the RCU

The RCU uses Reader information files to identify the Readers installed within an institution. Once a
Reader has been identified, you can use the RCU to change Reader-specific settings.

A USB flash drive is used to transfer Reader settings between the Reader and the RCU.

1 To change Reader-specific settings in a non-networked environment: Insert a USB flash drive into an
available USB port on the CM. Ensure that the USB drive contains four folders named: Iqc, patient,
igc, and log.

Navigate to the Settings menu (Menu > Settings) and select Export Configuration.

Select Export to USB Flash Drive. All settings files and result logs are exported.

(Optional) Export the configurations for additional Readers.

Insert the USB flash drive into the RCU computer’s USB drive.

From the RCU, click File > Open and select USB Device (navigate to the correct location of the USB
device if this function does not work automatically).

Select Files of Type: Readers, select the desired Reader serial number and then click Open. On the
Reader Settings menu, you can now define changes to settings for the selected Reader.

To change Reader-specific settings in a networked environment:

Each Reader must be placed into network mode and must be assigned a device information directory

prior to successful bi-directional communications.

1 Using the Reader touchscreen, select Menu > Settings > Edit Settings > File tab. The File tab
appears.

Enter the Device and Group Directory settings for the Reader as defined in the RCU.

Select the Misc tab and enable the Auto Transfer Mode option.

From the RCU, select File > Open and then select Network.

Select Files of Type: Readers, browse to the device directory for the Reader of interest, select the
desired Reader serial number and then click Open. On the Reader Settings menu, you can now
define changes to settings for the selected Reader.

=% RESPONSE BIOMEDICAL 58



RAMP® 200 USER MANUAL

Maintenance

MAINTENANCE ‘J

=% RESPONSE BIOMEDICAL

59



RAMP® 200 USER MANUAL Maintenance

Maintenance

WARNING! Do not disassemble the RAMP® 200 or any of its related components and
f accessories. The instrument contains no operator-serviceable components.

Possible electrical shock
Unplug RAMP® 200 devices before you clean the system.

Maintenance Guidelines

The RAMP® 200 does not contain any operator-serviceable components.
Beyond gentle exterior cleaning, the RAMP® 200 does not require regular maintenance or calibration.

Any liquids on the external surface of a Test Cartridge must be cleaned before inserting into the ports of
the TM.

Upgrading Device Software

Software upgrades are installed by a USB flash drive that contains the latest software.

To install a software upgrade:
1 Select Menu > Settings > Upgrade. The Settings: Upgrade screen appears.
Settings: Upgrade % RAMP'

Choose Upgrade
NOTE: After Upgrade System Will Need To Be
Restarted

Upgrade CM Software |

Upgrade Port Software |

Upgrade Languages | Cancel

NOTE: The first of the three upgrade options is always the upgrade for the CM software. However,
in CM software V1.2 and in earlier CM versions, this option is labeled Upgrade All Software (not
Upgrade CM Software).

Select the appropriate upgrade option:
Upgrade CM Software upgrades the CM software only
Upgrade Port Software upgrades the TM only
Upgrade Languages Only upgrades the language software

Select Confirm to start the upgrade. Please wait until the Upgrade has completed, the system will then
prompt you to restart the system to complete the upgrade.

Power off the RAMP® 200, wait approximately 30 seconds, and then power the system back on.
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NOTE: To prevent an Assay Error, Port Failure message and to avoid any unexpected printing of labels,
ensure that your connected printer is turned off during the upgrade.

Exterior Cleaning

& CAUTION. Possible device damage

Do not immerse the RAMP® 200 or related devices in any liquid. Avoid spilling liquids
on the RAMP® 200 and related accessory devices.

The external surfaces of the TM and CM can only be disinfected using a solution of 0.5% bleach or 70%
ethanol applied to a soft cloth. DO NOT USE STRONG BLEACH (>0.5% solution) OR ACETONE! Oxidants
and solvents could damage the RAMP® 200 casing and touchscreen. Clean external surfaces only.

If RAMP® 200 requires repair or replacement, it must be disinfected prior to repackaging and shipping.

CAUTION. Risk of permanent equipment damage

/ f % Do not expose the RAMP® 200 to temperatures above 60°C (140°F). Do not disinfect
or sterilize the RAMP® 200 using devices such as autoclaves, ultrasonic cleaners, or
pasteurizers. Use of such methods to disinfect/sterilize the RAMP® 200 causes
permanent device damage and voids the warranty.

Waste Electrical and Electronic Equipment (WEEE)

Do not dispose of this product in municipal waste. Contact Response Biomedical Technical Support to
arrange disposal and recycling.
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Troubleshooting

This section explains problems and provides solutions for general operating issues and for error
messages that appear on the CM screen. If you need additional assistance, use the following information
to contact Response Biomedical.

24-Hour Response Biomedical Technical Support

Toll free: 1 (866) 525-7267 (North America only)

Tel: 1 (604) 219-6119 (International)
E-mail: techsupport@responsebio.com
General
Problem Solution
CM touchscreen is hard to read Contact Technical Support to report the problem.
(very dim), or colors are not
visible.
CM does not turn on or light up. Check if any cable connections are loose. Check system power; ensure power supply is

connected. If problem persists, contact Technical Support to report the problem.

TM is not recognized by CM. Check if connections are loose. Switch the CM off and then on. If the problem persists,
contact Technical Support to report the problem.

Power-on Self Test Message / IQC Messages

Message Cause(s) Solution
No Available Ports. 1QC Failed To Ports are disabled. Switch the CM off and then on. If the
Start. problem persists, contact Technical

Support to report the problem.

“Cartridge in Port” “Fail” An IQC/POST critical failure may lead Failed port is disabled. Switch the CM
subsequent IQC Tests to display as FAIL. The  off and then on. If the problem persists,
“Cartridge in Port” error might also display contact Technical Support to report the
on the 1QC result printout when thereisno  problem.
cartridge in the TM port.

“Incorrect Firmware On One or This generally occurs when the CM Upgrade the TM firmware. Select Menu

More Ports software is upgraded to a newer version > Settings > Upgrade and select

Ports Disabled Until Upgraded” and becomes incompatible with the TM Upgrade Port Software. For more
firmware. information, see Upgrading device

software on page 60.
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Test Run Messages

Test run messages are indicated by a red port icon:

>

Troubleshooting

Do not remove the cartridge. Select the icon to display detailed information about the failure. If the
cartridge is removed, you can access this information by viewing the error log from the main menu.

Port display Message

Cause(s)

Solution

CTG Cartridge Error

HRB High Background

Possible defect in Test Cartridge.

Possible interfering substances in the
sample causing high running
background.

LOW Low Signal

Fail Sample Error 1

Fail Sample Error 2

Insufficient sample transferred to the
Test Cartridge.

Insufficient mixing of the sample with
the supplied Assay tip.

Substances in the sample are interfering.

Sample flow occurred before the Test
Cartridge was inserted into the port.

Delay of more than 30 seconds between
sample addition and Test Cartridge
insertion.

Insertion of a used Test Cartridge.

Sample flow has not been detected.

The sample injected into the Test
Cartridge is insufficient.

Clogged sample pad.
Failure to use supplied Assay tip.
Insufficient mixing of sample.

Substances in the sample are interfering.

Analyte levels are significantly higher
than the upper reportable range.

The Test Cartridge is ejected.

Remove and dispose of
appropriately.

Repeat the Assay with a fresh
set of components.

If the problem persists, contact
Technical Support to report the
problem.

Fail Temperature Error

Error XX Port Disabled

e.g., Error 2B

TM is not at the proper temperature to
complete the requested Assay.

The identified port is disabled due to an
IQC failure or a transport carriage
failure. LED remains illuminated red.

Contact Technical Support to
report the problem.

Contact Technical Support to
report the problem.
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Message / problem

Cause(s)

Troubleshooting

Solution

Insertion Error Remove & Reinsert

Followed by:
Timed Out

The Test Cartridge was not inserted
properly into the RAMP® 200 or the
operator did not wait until prompted.

User has not performed the action
required within the maximum
allowed time.

Cancel the Assay or reinsert the Test
Cartridge. Fully insert Test Cartridge until
you feel firm resistance. Do not use
excessive force. The TM automatically
pulls the Test Cartridge into the port.

NOTE: You must reinsert the Test
Cartridge into the TM port within
approximately 30 seconds. If you do
not, the system aborts the Assay and
displays an error message.

Repeat Assay using a fresh set of
components.

Barcode Error Aborting Assay

No Ports Available, Assays in Progress

The RAMP® 200 was unable to read
the barcode on the Test Cartridge.

All ports are in use by other Assays.

Repeat Assay using a fresh set of
components.

Select OK, to return to the main menu
and wait until an Assay is complete
before you attempt to run another test.

No Ports Available, Remove
Cartridge(s) Try Again

Lot Card

Message / symptom

No response to insertion of a Lot Card

Cartridges occupying all ports.

Cause(s)

The Lot Card assembly is not
functioning.

Remove the Test Cartridge(s) of

completed Assay(s).

Solution

Contact Technical Support to report the
problem.

Lot Card Error, Reinsert

The system did not read the Lot Card
correctly.

The Lot Card may have been removed
too quickly, or may not have been
fully inserted into the Lot Card slot.

Select OK, and then reinsert the Lot Card.
If the problem persists, use a Lot Card
from another box of Tests with the same
lot number.

If another Lot Card is not available or
alternate Lot Card fails, contact Technical
Support.

Lot # XXXX Not Found, Insert Lot Card
or Cancel

Lot Card Expired

The RAMP® 200 does not contain the
data required to run Test Cartridges
with that lot #.

The Lot Card may not have been read
before running the Assay.

The inserted Lot Card has expired.

NOTE: Expiry falls on the last day of
the month.

Insert the Lot Card for the specified lot or
cancel Assay.

NOTE: If you do not insert the Lot Card
within approximately 30 seconds, the
system aborts the Assay.

Use a fresh set of components and repeat
Assay.

Check the RAMP® 200 date/time
settings.

Use components that have not expired.
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Settings Messages

Message

Cause(s)

Troubleshooting

Solution

Access denied. Try again.

Assay List Size Exceeded.

The user does not have the login
permissions necessary to access
selected function.

The list of Assays permitted is full. No
further additions can be made.

NOTE: The maximum number of
Assay entries allowed is 200.

Confirm correct login details and try
again.

Delete existing Assays from the Assay
List. For complete instructions, start
the RCU, press F1|and refer to the
online help.

Assay Locked, Aborting.

The Assay is not permitted or has been
locked. May occur if LQC has failed or if
the Assay is not in the Assay list.

For more information, contact the
Supervisor or a full access RCU user.

Database Almost Full, Backup Data.

Displayed when RAMP® 200 is not
connected to a network and either the
patient or LQC result databases have
less than 20 spaces left. This message
continues to appear until the database
is cleared.

Export data to a USB data storage
device and then delete the database.

Default Restore Failed.

The action to restore defaults has
failed.

Try this process again. If the problem
persists, contact Technical Support.

ERROR: Invalid Code. Try Again.

ERROR: Numbers Only.

The override code entered is invalid.

Only numbers are permitted in the
override code field.

Contact Technical Support, and then
enter the override code provided.

Enter the code number provided by
Technical Support.

Invalid Password, Try Again.

Invalid User, Try Again.

The password was incorrectly entered.

The user is not recognized or has been
entered incorrectly.

Retype the password and try again.

Retype user details and try again.

Locked, Contact Supervisor.

The RAMP® 200 has been locked by
the RCU.

Contact a full access RCU user to
unlock using the Reader Settings
screen.

Empty Search.

The RAMP® 200 cannot find the
requested record. It may have been
deleted or its details may have been
entered incorrectly.

Re-enter the search data and try again.

User Expired, Try Again.

User certification has expired or the
details were entered incorrectly.

Re-enter the operator ID or contact the

Supervisor.
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LQC Related Messages

Message

Cause(s)

Troubleshooting

Solution

LQC Lockout. Ejecting.

LQC is overdue for this Assay and no
overrides are available.

LQC must be run and passed, or a full
access user can reset the LQC timer
and/or override for this Assay in
Reader Settings on the RCU.

Invalid Assay or Control, Aborting LQC.

An incorrect Assay has been selected to
run LQC.

Repeat LQC with the correct Assay or
contact the Supervisor.

LQC required. Assay Aborted. Ejecting.

Warnings and Confirmation Requests

Message

! All Databases Will Be Erased
Back up files at Settings: Export
Configuration

System will restart following this
procedure

LQC has expired and all available
overrides have been used. Tests cannot
be run until the required LQC has been
run and passed.

Cause(s)

Request was made to upgrade software
or reset system to default settings.

| All Results Will Be Deleted

ERROR - Missing Firmware Version File

Request was made to delete all results.

The file required to complete the
upgrade is missing.

Run the required LQC.

Solution

Cancel if not intended.

Before performing this operation, all
databases should be backed up using
Export Configuration.

Contact Technical Support

ERROR - Upgrade Failed
Restart to Try again

Upgrade failed.

Restart the RAMP® 200 and re-try
upgrade. If the problem persists,

contact Technical Support.
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Printer Errors

Message / problem

Cause(s)

Troubleshooting

Solution

Printer Error.

a

Poor print quality.

The RAMP® 200 is not able to
communicate with the printer.

The printer may be offline.

The printer could be using the wrong
print labels or print ribbon.

Reconnect the printer, switch it on and
try again.

If the printer is not being used, turn off
Auto Print via the RCU. For complete
instructions, start the RCU, press @
and refer to the online help.

Refer to the printer manual.
Consumables required for TLP 2824™
or TLP 2824 Plus™ printer:

Labels: 2.25” W x 3” L Z-Select 4000T
labels from Zebra” Technologies (part
number: 800222-305);

Ribbon: 57mm x 74m Wax/Resin
Ribbon from Zebra” Technologies (part
number: 800132-102)

Failure to print.

Poor cable connection or jammed
printer.

Check if any cable connections are
loose. Check if the printer is jammed;
refer to the printer manual for
instructions. If the persists, contact
Technical Support to report the
problem.

Printer light does not turn on.

Printer is not receiving power.

Communications Errors

Message

Transfer Error

=

Transfer Failed

Cause(s)

Network communications error or an
error writing to the USB flash drive.

Refer to the printer manual. Check
system power; ensure the power
supply is connected. Ensure that the
switch on the bottom right-hand side
of the printer is in the On position. If
the problem persists, contact Technical

Support to report the problem.

Solution

Check all cable connections and try
again.

If the problem persists, contact the
Supervisor or Technical Support.

IP settings disabled while network
transfers are set to auto

Attempt to set IP address while
Transfer Mode is Auto.

Set Transfer Mode to Manual, enter
the IP address information, and set the
Transfer Mode to Auto.
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USB Device Errors

Message

Cause(s)

Troubleshooting

Solution

Multiple Printers Attached, Remove
Device

Multiple USB Drives attached, Remove
Device

Two USB printers are connected. Only
one printer is permitted.

More than one USB device of the same
type is connected.

Remove the additional printer.

Remove the additional USB device.
Leave one connected.

Unrecognized Scanner or Keyboard,
Remove Device

Device attached is not supported by
the RAMP® 200.

Remove the device.

NOTE: The barcode scanner must be
configured for HID keyboard
emulation (Refer to the Scanner
Quick Start Guide).

If the problem persists, contact
Technical Support.

USB Not Visible, Reinsert & Try Again

Unrecognized USB Drive attached,
Remove device

The USB device is not detected by
RAMP® 200.

A USB drive without a valid partition
table is inserted into the CM.

Re-connect the USB device and try
again.

Use the USB drive that is supplied with
the RAMP® 200.
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SPECIFICATIONS L
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Specifications

AN

Specifications

CAUTION. Possible device damage and warranty invalidation.
Changes or modifications to this equipment, not expressly approved by the manufacturer,
could void the warranty.

TM Specifications

Specification

Model Name

Description

RAMP® 200 TM

Dimensions

Weight

185mm D x 195mm W x 96mm H
1.5kg

External connections

(1) RS485 - TM to CM

CM Specifications

Specification

Description

Model Name

RAMP® 200 CM

Dimensions 177mm D x 195mm W x 105mm H
Weight 1lkg
Input Power Requirements 12V DC, 120 W

Power Supply
Power Cord Length

100 - 240 VAC, 50-60 Hz
4 ft (1.22 m) min from power supply to CM

Power Supply Input Connector

Power Supply Standards

IEC 320 C14 compatible

Certified for CE, CSA, UL, C-Tick, according to intended regions. Conforms to WEEE
and RoHS requirements for non-medical electronic devices.

External Connections

Ethernet Connectivity

USB 2.0 and 1.1 (3 available), RJ-45 Ethernet, Serial RS-485 (3 available),
TCP/IP, DHCP dynamic IP addressing, SSL over TCP, HTTP, HTTPS, FTP, FTPS

Controls

Supported USB Devices

Display

On/Off toggle switch. O = off /I = on.

Touchscreen: VGA LCD alpha-numeric display, accepts input from bare finger, latex or
nitrile gloved finger, or stylus.

Touchscreen buttons: Main Menu, Run Assay, Run LQC, I1QC, Results, Settings,
Operator List, Cartridge status area (6).

Label printer: Zebra® TLP 2824, Zebra® TLP 2824 Plus,

Zebra® 888-TT

Generic USB flash drive

Barcode scanner: Symbol Technologies LS9208.

640 x 480 pixels, 5.7~6.5 " diag (14.48~16.51 cm diag).
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Specifications

TM / CM Specifications

Specification

Description

Operating Temperature

Storage/Transport Temperature

15 - 302 C (59 - 862 F)
-10- 502 C (14 - 1222 F)

Storage/Transport/Operating
Humidity

Operating/Storage Elevation

20 —90% relative humidity, non-condensing.

0-2000m

Pollution Degree

Installation Category

2
I

Complies with the following EMC
Specifications:

Complies with the following IEC
Standards:

FCC47 CFR Part 15

IEC 61326-1 — Electrical equipment for measurement, control and laboratory use —
EMC requirements

UL/IEC 61010-1 - Safety requirements for electrical equipment for measurement,
control, and laboratory use.

UL/IEC 61010-2-101 - Particular requirements for in vitro diagnostic laboratory (IVD)
equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user is required to
correct the interference at his own expense.

& Caution: Changes or modifications to this equipment not expressly approved by the manufacturer could void the user's

authority to operate the equipment.
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Settings: View Screen Tabs

This section describes the individual tabs in the Settings: View screen. For overview information on
viewing system settings, see Viewing system settings on page 44.

To access these tabs, select Menu > Settings > View Settings. The Settings: View screen appears.

Assay Tab
Settings: View = RAMP’

Assay LQC Timer Printer Login File About

| Patient ID New Assay Lockout

Field Title:  Patient ID Lockout New Assays: No
Min Length: 1
Max Length: 18

Pradefined Notes

Menu

You can only edit the Assay tab settings through the RCU.

Sample/Patient ID

Defines the field name. Default is Patient ID. Alternate is Sample ID. String length can be set from 1 to 18.
Default: Min Length = 1, Max Length = 18.

New Assay Lockout
Defines the ability of operators to perform Assays that are not in the Assay list. Set as Yes or No.

Yes: End users cannot run any Assays that are not on the RCU defined Assay list. The defined Assay list
appears on the LQC — Assay List screen (select Menu > LQC).

No: End users can run any RAMP® 200 Assay. Default: No.

Predefined Notes

All notes predefined through the RCU are displayed. You can add one of these notes to each patient test
result prior to removing the Test Cartridge from the TM. Once appended, the note becomes part of the
result.

NOTE: The predefined note can be up to 20 characters in length. For CM software V1.2, initial setup of
the notes feature requires use of the default grp_settings file that is installed with the RCU (see the
Editing settings using the Reader Configuration Utility (RCU), starting on page 52). For CM software
V1.3, initial setup of the notes feature can now be completed using the grp_settings file exported from
the CM.
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LQC Tab

Setlings: View *RAMP
Assay LQC Timer Printer Login File Aboul

LaC
Hidlo Mumeric LOC Results: Hao

LG Timeoid Wamang (% remaining): 10
biax Failures Before Lockoul: -]

Contred ID
Min Length: 1

Max Length: 18

Menu

You must use the RCU to edit the LQC tab settings. They cannot be edited in the CM.
Default: Timer Reset (hours) = 0, LQC will not time-out.

To Hide Numeric LQC Results and report only PASS/FAIL.
Set as Yes or No.
Yes: Pass/Fail appears in place of results.
No: Actual result appears.
Default: No.

If LQC is required, display LQC Timeout Warning (% remaining):
Before LQC expires (for any Assay), the LQC warning icon appears when the user-defined LQC Timeout
Warning counts down to its specified percentage. Default: 10%.

If LQC is required, display Max Failures Before Lockout:
The number of LQC failures allowed before Assay is locked out. Can be set from 1-9. Default: 1.

Control ID

String length can be set from 1 to 18.
Default: Min Length = 1, Max Length = 18.

Timer Tab

Settings: View * RAMP’

Assay LQC Timer Printer Login File About

Timer Intervals

Menu Idle Timoeout (minutes): 8

Update/Upload Start Date/Time:  2006-12-31 17:00:00

Update Interval (minutes): 1

Upload Results Interval (minutes): 0

Auto IQC Interval (minutes ). 0

Menu

Use this tab to view the time and timer interval settings.
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NOTE: The ability to edit the settings of the Timer tab varies by item.

Timer Intervals
Menu Idle Timeout - Edit on the CM. Cannot edit through the RCU.

Amount of idle time before the RAMP® 200 returns to the home screen. To disable, enter 0. Range: O -
10 minutes. Default: 5 minutes.

Update/Upload Start Date/Time — Edit through the RCU only.
The date and time used to calculate the start of the following intervals:
1. Update Interval — Edit through the RCU only.

Interval at which the Reader checks for changes to settings in a networked environment. Disable by
entering 0. Range: 0 - 1440 minutes. Default: 1.

2. Upload Results Interval — Edit through the RCU only.
Interval at which the Reader sends additions to the result and event logs in a networked environment. To

disable, enter 0. Range: 0 - 1440 minutes. Default: O (Disabled).

NOTE: Only new results not previously transferred are transferred during an upload. Data is not
deleted from the CM upon transfer. When the CM database is full, the oldest result is over-written.

3. Auto IQC Interval - Edit on CM and through the RCU.

The interval between automatic 1QC self-diagnostics in either local or networked environment. To
disable, enter 0. Range: 0 - 1440 minutes. Default: O (Disabled).

Printer Tab

Settings: View > RAMP'
Assay LOC Timer Printer Login File Aboul

Mo Prind
Asnay: 0N
LaC: Of
ac: o

Print Headara
e

t -4

Menu
You must use the RCU to edit the Printer tab settings. They cannot be edited in the CM.
Auto Print
Automatic printing can be enabled independently for Assay, LQC and 1QC results.

On: Prints the result automatically when the Assay is done.

Off: Does not print the result automatically. - Default: Off
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Print Headers

Customized print header information that is visible on every printout.

Login Tab

Setlings: View > RAMP'
Assay LOC Timer Printer Login File Aboul
Dawvice Name: Lockout: Device Uinloched
Logen Requiremants
Chparntors: Maong
Supenisors: ) and Passwond
Privilege Requiremants
Run Assey: All Operators
Whew Rosults: Al Operators
Run LQC: All Opwrators
Run 3G All Operators
Seltings: Superdsors Only
Menu

You must use the RCU to edit the Login tab settings. They cannot be edited in the CM.

Device Name
Name that has been assigned to the device.

Default: Blank.

Lockout
Disable Reader
Device Locked: Assays cannot be run.

Device Unlocked: Assays can be run (default).

Login Requirements

Login requirements can be set independently for operators and supervisors requiring ID and password,
ID only, password only or none. If none, an operator ID cannot be entered when running Assays.

Default: Operators = None; Supervisors = ID and Password.

Privilege Requirements
Defines the access privileges for each user level.

All Operators: Operators and supervisors have access.
Supervisors only: Only supervisors have access.

Default values: Run Assay: All Operators
View Results: All Operators
Run LQC: All Operators
Run IQC: All Operators
Settings: Supervisors Only
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File Tab

Settings; View > RAMP*
Assay LQC Timer Printer Login File  About
Matwork Settings
Manual Transfer Mods P Address: Mo IF sddress
MAC Address: 006000 01:82:E8
File Locations
Device Seltings: iy
Group Seftings: filetlgrp_seltings.dtv
Azawy List: filacil/ameayn.div
Controd List: Tluieontrolsdiy
Dperator Lt Fle:usariistopl
Results: fileiresults
Time Server:
Menu

You must use the RCU to edit the network settings for the Reader tab settings. They cannot be edited in
the CM.

Network Settings

Manual Transfer mode: The RAMP® 200 is used without connection to a shared network.

IP Address: By default, the IP address is auto assigned when the RAMP® 200 is connected to a network
and in Auto transfer mode. Alternatively, a static IP address can also be assigned (see IP tab on page
81).

MAC Address (Machine Address Control address): This static address is the network identity of the
RAMP® 200. Default: Manual Transfer Mode.

File Locations

Displays the location where the RAMP® 200 files reside, defined when implementing connectivity
through the RCU. Consult your local IT administrator or the RCU help manual for information and help on
how to use these settings.

About Tab

Settings: View = RAMP
Assay LOC Timer Printer Login File About
System Varsions

Serial 2 Softeara Hardwara
cM AB01074 10431 10

1TH 1A T Mot Connected
Z2TM 18 Tl Mot Connected
3TM A T Mot Connected

4T 2B Thl Hot Connected
5 TM 34 BODIOET-A 106 110
6 TM 38 BoO102ET-8 1.00 110

Menu

This tab displays the details of the serial number, software and hardware versions of the system. This
information is important during discussions with Response Biomedical Technical Support.
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Settings: Edit Screen Tabs

This section describes the individual tabs in the Settings: Edit screen. For overview instructions on
editing settings, see Editing system settings on page 45.

To access these tabs, select Menu > Settings > Edit Settings. The Settings: Edit screen appears.

Timer Tab

Settings: Edit = RAMP
Timer File Date/Time Language Misc. IP

1QC Interval (minutes) 0

Menu Idle Timeout (minutes) 5

IQC Interval (minutes)

Use this field to specify the interval between completing automatic IQC self-diagnostics. You can edit this
value either on the CM or in the RCU.

Range: 0 — 1440 minutes
Default: 0 (Disabled)

Menu Idle Timeout (minutes)

Use this field to specify the amount of idle time before the RAMP® 200 returns to the home screen.
Default: 5 minutes.

You must use the CM to edit this field value. You cannot edit the value in the RCU.

NOTE: The ability to edit the settings of the Timer tab varies by item.
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File Tab

Settings: Edit * RAMP’
Timer File Date/Time Language Misc. IP|
Device  [file:ll Clear
Group filesi Clear
Time Server |file:l! "~ Clear

Alt. Keys  Shift Reset  Cancel  Save

Tab Guidelines

Use this tab to specify the locations for the device, group and time server settings.
You can edit these values either on the CM or in the RCU.

Consult your local IT administrator and the RCU help manual for guidance on how to configure these
settings.

Date/Time Tab

Settings: Edit > RAMP
Timer File Date/Time Language Misc. IP |
Time Zone: GMT-08:00 . Date Formal: yyyy-mm-dd -
Dats: Yoar (2000 Manth 8 Dy 18

Tab Guidelines

Use this tab to set the current date and time on the system.
You can only edit these values on the CM. They cannot be edited through the RCU unless NTP is enabled.

If you are in Auto Transfer Mode, the RAMP® 200 date and time may be synchronized with the NTP
server.

The date format in the Reader is variable. The date format in the RCU is the same as for other
applications running on that PC.

Periodically check that the clock is correct and has not inadvertently changed.
To configure the values of the Date/Time tab:

1 Inthe drop-down menu, scroll through times zones and select the time zone offset for your location.
Use the touchscreen keyboard and enter the current time.
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Switch the CM off and then on again to reset the values.

Specifications

NOTE: When you adjust for changes in daylight savings time, remember to set the accurate Time Zone

offset and not just the accurate current time.

Language Tab

Settings: Edit

# RAMP’

Timer File Date/Time Language Misc. IP

Language English

Xlwl=n

4
R
F
v

Ni»|O}) =
ojolmjw

ool Hlw

Z|T|=<}|>

Zl=lc]~

=]

- #

<= /

Al Keys  Shift = Reset Cancel Save

Tab Guidelines

Use this tab to set the display language for the RAMP® 200.
You can only edit these values on the CM. You cannot edit them in the RCU.

CM software V1.3 supports the following languages: Chinese, French, German, Italian, Portuguese and

Spanish. CM software V1.2 only supports English.

The barcode scanner does not support scanning of the extended character sets on the Alt. Keyboard

(ALT. KEYS)).
Misc. Tab

Settings: Edit i+ RAMP'
Timer File Date/Time Language Misc. | IP
Manual / Aute Transfer Mode Manual Transfer Mode -
Sound Test | Om
1234567 isogqoyp\y:
QIWIEJR|TIYJUjI|OfP|l@]| ~
AISIDJFIGIH|JYKILY-§_1 #
ZiX|CV|iBIN|M <-f /

Al Keys Shift = Reset Cancel Save |

Network Transfer Mode

You can only edit these values on the CM. You cannot edit them in the RCU. Default: Manual Transfer

Mode.

Manual Transfer Mode: the RAMP® 200 is set up for stand-alone operation.
Auto Transfer Mode: the RAMP® 200 is set up for network operation.
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Sound

You can only edit these values on the CM. You cannot edit them in the RCU.

NOTE: There is no volume adjustment feature.

Test: Select to hear indicator.

On: The audio indicator is ON and sounds at the completion of an Assay and when a USB device is
connected or disconnected.

Off: The audio indicator is OFF.

IP Tab

Settings: Edit > RAMP
Timer File Dale/Time Language Misc. IP
IP Made: = DHCP Static IP

P: Cluar|  Subnet: Clear

DHS Claar| Gatewwy: Clear

Cancel . Save

Tab Procedure
1 Before you begin, ensure that the Manual/Auto Transfer Mode option is set to Manual
Transfer Mode (select Menu > Settings > Edit Settings > Misc. tab).

Consult your local IT administrator and the network setup guide for the information you need to
configure these settings.

Return to the Misc. tab and set the Manual/Auto Transfer Mode option to Auto Transfer Mode.

NOTE: The IP screen is only available on CM software V1.2 and above.

IP Mode
You can only edit this setting on the CM. You cannot set it in the RCU. Default: DHCP.

DHCP: IP address assigned dynamically by host network.
Static IP: A fixed IP address is assigned on this screen.
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USER AGREEMENT & WARRANTY
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User Agreement and Warranty

This User Agreement and Warranty (this “Agreement”) is an agreement between you and Response Biomedical Corporation (“Response”) and
governs the purchase and use of your RAMP’ 200 System. The RAMP® 200 System comprises the Control Module (“CM”), Control Module
software (“CM Software”) one or more Test Module(s) (“TM(s)”), the Reader Configuration Utility Software (“RCU Software”), the power supply
and interconnect cable, the USB flash drive; and optionally includes USB devices supported by the RAMP® 200 System such as the barcode
printer and barcode scanner (“Optional USB Devices”) (collectively ”RAMPQ”). Software Updates (defined below), which are released subsequent
to the date of purchase of RAMP” are not included as part of RAMP” and are not subject to the terms of this Agreement except as expressly set
forth below. This Agreement sets out Response’s warranty of RAMP’, exclusions and limitations of Response’s liability to you, provisions
governing the recall, and exchange policies for RAMP’, and other important provisions. If you do not agree with any term of this Agreement, you
must not use RAMP’, and may return RAMP’ to the RAMP" distributor from which you purchased RAMP within 30 days of the date of receiving
RAMP’ (“Date of Receipt”). If you use RAMP”, you are deemed to have agreed to the terms of this Agreement.

Return Policy

Returns must be marked as RETURN and must include proof of purchase and the bill of lading. Returns must be received by Response within 30
days of the Date of Receipt. Upon acceptance of the terms of this Agreement, all sales are considered final.

Receipt of Delivery

The entire order is guaranteed to be correct. It is the purchaser’s responsibility to open the package and inspect the items upon delivery.
Packages that appear to be damaged should be immediately reported to the freight carrier. Damage due to shipping is the sole responsibility of
the freight carrier and all claims are to be made by the purchaser directly with the carrier immediately upon recognizing a problem. Shipping
carriers may not honour late claims. Response will not accept Returns or Exchanges due to shipping damage.

In the case of wrong-shipped items (“Wrong-Shipped Items”), the purchaser should notify the distributor of the error as soon as possible, but
not later than 30 days from the Date of Receipt (the “Exchange Period”). Exchanges for Wrong-Shipped Items are handled in accordance with
the Exchange Policy noted below.

Exchange Policy

The Exchange Policy applies only to newly purchased RAMP”, including any newly purchased Optional USB Devices, and is in effect for the
Exchange Period only. Upon the expiry of the Exchange Period, the Warranty provisions of this Agreement, if applicable, govern.

All exchanges, whether for defect or otherwise, are to be made through the distributor where the item was purchased. Response will not accept
any exchange claims directly from the purchaser. For purposes of requesting an exchange, the purchaser should contact the local distributor’s
Technical Support Representative as soon as possible, but not later than 30 days from the Date of Receipt. All exchange requests should be
handled in accordance with this Exchange Policy.

In the case of Wrong-Shipped Items, Response will work with the distributor to replace these items with the proper items, at no charge to the
purchaser. In the case of defective items (“Defective Items”), where said defect was NOT caused by shipping damage, misuse, neglect,
unauthorized attempts to open, repair or modify RAMP’, or use of RAMP" with accessories or other products that are not authorized by
Response, Response will work with the distributor to replace the Defective Item.

Prior to shipping any item for exchange, whether the item is defective or otherwise, the distributor must first contact Response to obtain
written authorization for the exchange. Response will provide the instructions on how to ship the return. Response will not accept shipments
without a confirmed, written authorization. All the return items authorized for exchange must be in the original (or equivalent) packaging and in
compliance with the freight carrier’s requirements. Response will pay the shipping charges for the product exchange.

Replaced items will be shipped to the purchaser (or distributor where appropriate) upon receipt and inspection of the Defective or Wrong-
Shipped Items by Response. Replacement of all items remains subject to in-stock availability.

Warranty

Response warrants to the original purchaser that RAMP” will be free from defects in material and workmanship on the date of purchase and
substantially conform to the material functional specifications contained in this Owner’s Manual for a period of one (1) year from the date of
the original purchase from Response or an authorized distributor (“Warranty Period”). This limited warranty is non-transferable. This warranty is
conditioned upon observance of the published directions included in this Owner’s Manual. This warranty is further conditioned upon
observance of directions accompanying the products specifically designed for use with RAMP’ and authorized for use with RAMP’ by Response
(including Test Cartridges, control Cartridges and Kits containing same) (the “RAMP"” Products”).

This warranty does not apply if the defect or malfunction in RAMP’ was caused by misuse, neglect, unauthorized attempts to open, repair or
modify RAMP’, use of RAMP’ with accessories or other products that are not RAMP Products or any cause other than the intended normal use
of RAMP".
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If RAMP® becomes defective during the Warranty Period, and the Exchange Period has expired, the purchaser’s sole and exclusive remedy, and
Response’s sole obligation, will be to repair or replace RAMP". Repaired or replaced products or parts may be new or reconditioned, and are
subject to this limited warranty through the end of the original Warranty Period. Non-warranty work is charged at the standard repair rate.

To obtain warranty service, the purchaser must contact the distributor during the Warranty Period, provide the distributor with a dated proof of
original purchase, and ship RAMP' to Response in its original (or equivalent) packaging only after receiving an authorization notice in writing
from either Response or the distributor. The purchaser is responsible for shipping costs to Response.

Exclusions

TO THE FULL EXTENT ALLOWED BY LAW, THIS LIMITED WARRANTY IS THE PURCHASER’S SOLE AND EXCLUSIVE REMEDY, AND NO OTHER
WARRANTIES, CONDITIONS OR GUARANTEES OF ANY KIND SHALL APPLY, WHETHER STATUTORY, WRITTEN, ORAL, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION WARRANTIES, CONDITIONS OR GUARANTEES OF MERCHANTABILITY, NON-INFRINGEMENT, FITNESS FOR A
PARTICULAR PURPOSE, PERFORMANCE, QUALITY, OR DURABILITY, ALL OF WHICH ARE DISCLAIMED.

Liability Limitations

IN NO EVENT WILL RESPONSE BE LIABLE FOR ANY SPECIAL, EXTRAORDINARY, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND
WHATSOEVER, INCLUDING WITHOUT LIMITATION DAMAGES FOR LOSS OF DATA, LOST PROFITS, LOSS OF OPPORTUNITY, PATENT INFRINGEMENT,
BUSINESS INTERRUPTION, PERSONAL INJURY OR DEATH, OR ANY OTHER LOSS ARISING OUT OF, RELATING TO, OR IN CONNECTION WITH RAMP”
EVEN IF RESPONSE IS ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IF, AS A RESULT OF OR IN CONNECTION WITH, ANY USE OF RAMPQ,
WHETHER IN CONJUNCTION WITH RAMP" PRODUCTS OR OTHERWISE, RESPONSE BECOMES LIABLE TO THE PURCHASER OR ANY OTHER PERSON
FOR ANY DAMAGES, LOSSES, COSTS, EXPENSES, OR OTHER LIABILITIES WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION (IN
CONTRACT, TORT OR PURSUANT TO STATUTE), THEN RESPONSE’S AGGREGATE LIABILITY TO ALL SUCH PERSONS WILL BE LIMITED TO AN
AMOUNT EQUAL TO THE PURCHASE PRICE PAID FOR RAMP" AND YOU HEREBY RELEASE RESPONSE FROM ANY AND ALL OBLIGATIONS,
LIABILITIES, CLAIMS OR DEMANDS IN EXCESS OF THIS LIMITATION.

The exclusion of certain conditions and warranties and the limitation of certain liabilities are prohibited in some jurisdictions, so these
limitations and exclusions may not apply to some purchasers.

Recall Policy

Recalls are actions taken by Response to remove certain serial or lot numbers of RAM P or specific RAMP” com ponents (”RAMPW Parts”), from
the market. Recalls may be conducted on Response’s own initiative, or by the request of a regulatory body. Response will inform the distributor
of the necessary recall information in writing via email or fax. Only lot or serial numbers of RAMP’ or RAMP" Parts (the “Recalled Product”) that
fall within the recall will be included.

The distributor will take full responsibility for collecting all Recalled Products from their customers and for taking proper actions to discard,
destroy, or send the Recalled Products to Response-designated destinations as instructed.

Upon return of the Recalled Product to the distributor, the purchaser’s sole and exclusive remedy, and Response’s sole obligation will be to, at
Response’s option repair the Recalled Product or replace the Recalled Product with a an equivalent Response product (if available) of equal or
lesser value. Failure to return the Recalled Product may result in Response, at their sole discretion, deciding not to repair or replace the Recalled
Product.

End User License Agreement

Subject to the terms and conditions of this Agreement, Response grants to the purchaser a limited, non-exclusive license to use RAMP’ for its
intended purpose, and to use the CM Software solely as preinstalled on the CM and the RCU Software solely to enable purchaser’s use of the
CM. The CM Software and RCU Software are together referred to as “Software”. This license may be terminated by Response effective upon
notice to the purchaser if the purchaser fails to pay in full all fees for RAMP". Response reserves all rights not expressly granted to the purchaser
in this Agreement, including all proprietary rights in and to all designs and other technology and information pertaining to RAMP". Response
further retains all right, title, and interest, including all intellectual property rights, in and to the Software. The Software is licensed, not sold, to
the purchaser by Response and its suppliers. The purchaser will not have any rights in or to the Software except as expressly granted in this
Agreement. The limited end user license granted hereunder is not transferable and is limited to the purchaser of RAMP’ from Response or its
duly authorized distributor, except that this end user license may be transferred together with the permanent transfer of RAM P* and associated
documentation so long as (a) the purchaser does not retain any copies of the Software, (b) the transferee agrees to be bound by the terms and
conditions of this Agreement, and (c) the purchaser provides Response with written notice of the transfer within thirty (30) days of the transfer
date. Except as expressly provided in this Agreement, the purchaser will have no right to, and specifically agree not to, (i) disassemble, reverse
engineer, decompile, decrypt, or otherwise reduce RAMP’ or the Software to a human perceivable form to gain access to trade secrets or
confidential information in RAMP® or the Software (except to the extent that such restrictions are prohibited by applicable law); (ii) modify or
adapt or otherwise make error corrections to RAMP’ or the Software or create derivative works based upon RAM P° or the Software, or permit
third parties to do the same; (iii) make or distribute any copies of RAMP’ or the Software; and (iv) use the CM Software except as embedded or
preinstalled on the CM or the RCU Software except to configure the CM.
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Software Updates

Response may, in its sole discretion, provide replacements, updates, modifications, or bug fixes for the Software to the purchaser or a transferee
(“Software Updates”). Each Software Update is provided “as is” with no warranty of any kind. Software Updates will be deemed part of the
Software solely for purposes of the sections of this Agreement entitled LIABILITY LIMITATIONS and END USER LICENSE AGREEMENT.

Feedback

Any materials, including but not limited to feedback, comments, suggestions, or identifying potential errors, improvements, ideas or other
information provided by you in the form of email or other submissions to Response (collectively “Feedback”), are non-confidential and you
hereby grant to Response and its subsidiaries and affiliates a nonexclusive, royalty-free, perpetual, irrevocable, and sublicensable right to use
your Feedback for any purpose without compensation or attribution to you.

Governing Law

This Agreement is governed solely by the laws of the Province of British Columbia, Canada and applicable federal laws of Canada, and expressly
excludes the United Nations Convention for the International Sale of Goods, and any rules of private international law or conflict of laws which
would lead to the application of any other laws. Any dispute arising from, connected with or relating to this Agreement will be resolved by the
courts of British Columbia, Canada and the parties hereby irrevocably submit and attorn to the original and exclusive jurisdiction of those courts
in respect to such matters. This Agreement is in the English language. In the event this Agreement is translated into any other language and any
inconsistency or contradiction in meaning or interpretation results wherefrom, the English language version shall prevail and be controlling as
between Response and the purchaser. This Agreement constitutes the sole and exclusive agreement between the parties regarding RAM P and
the Software. If any provision of this Agreement is held invalid or unenforceable, the remainder of this Agreement will continue in full force and
effect.
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